
        
        

    Capítulo 6
Eclipse IDE

    
        
        
            "Dá-se importância aos antepassados quando já não temos nenhum."--François Chateaubriand

Neste capítulo, você será apresentado ao Ambiente de Desenvolvimento Eclipse e às suas principais
funcionalidades.


6.1 O Eclipse

O Eclipse (http://www.eclipse.org) é uma IDE (Integrated Development Environment). Diferente de uma
RAD, na qual o objetivo é desenvolver-se o mais rápido possível por meio do arrastar-e-soltar do mouse, e
montanhas de código são geradas em background, uma IDE o auxilia no desenvolvimento, evita se
intrometer e fazer muita mágica.

O Eclipse é a IDE líder de mercado, a qual é formada por um consórcio liderado pela IBM e tem seu código
livre.

Veremos aqui os principais recursos do Eclipse. Você perceberá que ele evita, ao máximo, atrapalhá-lo
e apenas gera trechos de códigos óbvios, sempre ao seu comando. Existem também centenas de plugins
gratuitos para gerar diagramas UML, suporte a servidores de aplicação, visualizadores de banco de
dados e muitos outros.

Baixe o Eclipse do site oficial http://www.eclipse.org. Apesar de ser escrito em Java, a biblioteca
gráfica usada no Eclipse, chamada de SWT, usa componentes nativos do sistema operacional. Por isso, você
deve baixar a versão correspondente ao seu sistema operacional.

Descompacte o arquivo e rode o executável.


Outras IDEs

Uma outra IDE open source famosa é o Netbeans da Oracle. (http://www.netbeans.org).

Além dessas, Oracle, Borland e a própria IBM têm IDEs comerciais e algumas versões mais
restritas de uso livre.

A empresa JetBrains desenvolve o IntelliJ IDEA, uma IDE paga que tem atraído muitos adeptos.





	
		Você pode também fazer o curso data dessa apostila na Caelum


		
			
		

		Querendo aprender ainda mais sobre? Esclarecer dúvidas dos exercícios? Ouvir explicações detalhadas com um instrutor?
A Caelum oferece o curso data presencial nas cidades de São Paulo, Rio de Janeiro e Brasília, além de turmas incompany.

		Consulte as vantagens do curso Java e Orientação a Objetos

	


6.2 Apresentando o Eclipse

Clique no ícone do Eclipse no seu desktop.

A primeira pergunta que ele lhe faz é que workspace você usará. Workspace define o diretório em que
as suas configurações pessoais e os seus projetos serão gravados.
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Você pode deixar o diretório pré-definido.

Logo em seguida, uma tela de nome "Welcome" será aberta, na qual você tem diversos links para tutoriais e ajuda.
Clique em Workbench.
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6.3 Views e Perspective

Feche a tela de nome "Welcome" e você verá a imagem abaixo. Nessa tela, destacamos as Views (em linha contínua)
e as Perspectives (em linha pontilhada) do Eclipse.
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Mude para a perspectiva Resource, clique no ícone ao lado da perspectiva Java, selecione Other e
depois, Resource. Nesse momento, trabalharemos com esta perspectiva antes da de Java, pois ela tem
um conjunto de Views mais simples.
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A View Navigator mostra a estrutura de diretório assim como está no sistema de arquivos. A View
Outline mostra um resumo das classes, interfaces e enumerações declaradas no arquivo em Java, atualmente
editado (serve também para outros tipos de arquivos).

No menu Window -> Show View -> Other, você pode ver as dezenas de Views que já vêm embutidas no
Eclipse. Acostume-se a sempre procurar novas Views, porque elas podem ajudá-lo em diversas tarefas.
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6.4 Criando um projeto novo

Vá em File -> New -> Project, seleciona Java Project e clique em Next.
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Crie um projeto chamado fj11-contas.

Você pode chegar nessa mesma tela ao clicar com o botão direto no espaço da View Navigator e
seguir o mesmo menu. Nela, configure seu projeto conforme a imagem abaixo:
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Isto é, marque create separate source and output folders, pois, deste modo, seus arquivos .java e
.class estarão em diretórios diferentes para você trabalhar de uma maneira mais organizada.

Clique em Finish. O Eclipse pedirá a troca da perspectiva para Java. Escolha No a fim de
permanecer em Resource. Na View Navigator, você verá o novo projeto, além das suas pastas e arquivos:
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Iniciaremos nosso projeto criando a classe Conta. Para isso, vá em File -> New -> Other -> Class.
Clique em Next e crie a classe seguindo a tela abaixo:
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Clique em Finish. O Eclipse tem diversos Wizards, mas o usaremos ao mínimo. O interessante é
usar o code assist e quickfixes, disponibilizados pela ferramenta, os quais veremos em seguida. Não se atente
às milhares de opções de cada Wizard, pois a parte mais interessante do Eclipse não é essa.

Escreva o método deposita conforme mostrado abaixo e note que o Eclipse reclama de erro em this.saldo, pois
este atributo não existe.
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Usaremos o recurso do Eclipse de quickfix. Coloque o cursor em cima do erro e aperte Ctrl + 1.
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O Eclipse sugerirá possíveis formas de consertar o erro; uma delas é, justamente, criar o campo
saldo na classe Conta, que é nosso objetivo. Clique nessa opção.
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Esse recurso de quickfixes, acessível pelo Ctrl + 1, é uma das grandes facilidades do Eclipse e é
extremamente poderoso. Por meio de seu uso, é possível corrigir boa parte dos erros na hora de programar e,
como fizemos, economizar a digitação de certos códigos repetitivos. No nosso exemplo, não precisamos
criar o campo antes porque o Eclipse faz isso para nós. Ele até acerta a tipagem, dado que o estamos somando a um double. O private é colocado por motivos que já estudamos.

Vá ao menu File -> Save para gravar. Ctrl + S tem o mesmo efeito.
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		Seus livros de tecnologia parecem do século passado?


		
			
		

		Conheça a Casa do Código, uma nova editora, com autores de destaque no mercado, foco em ebooks (PDF, epub, mobi), preços imbatíveis e assuntos atuais.
Com a curadoria da Caelum e excelentes autores, é uma abordagem diferente para livros de tecnologia no Brasil.

		Casa do Código, Livros de Tecnologia.

	


6.5 Criando o main

Crie uma nova classe chamada Principal. Colocaremos um método main para testar nossa Conta.
Em vez de digitar todo o método main, usaremos o code assist do Eclipse. Escreva só main
e aperte Ctrl + Espaço logo em seguida.
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O Eclipse sugerirá a criação do método main completo; selecione essa opção. O Ctrl + Espaço é
chamado de code assist e, assim como os quickfixes, são de extrema importância. Experimente usar o
code assist em diversos lugares.

Dentro do método main, comece a digitar o seguinte código:

Conta conta = new Conta();
conta.deposita(100.0);


Observe que, na hora de invocar o método sobre o objeto do tipo Conta, o Eclipse sugere os métodos possíveis.
Esse recurso é bastante útil, principalmente, quando estivermos programando com classes que não são as
nossas, como da API do Java. O Eclipse aciona tal recurso quando você digita o ponto logo após um
objeto (pode também usar o Ctrl + Espaço para acioná-lo).

Imprimiremos o saldo com System.out.println. Mas, mesmo nesse código, o Eclipse nos
ajuda. Escreva syso e aperte Ctrl + Espaço que o Eclipse escreverá System.out.println() para você.

Para imprimir, chame o conta.getSaldo():

System.out.println(conta.getSaldo());


Note que o Eclipse acusará erro em getSaldo(), porque esse método não existe na classe Conta.
Usaremos Ctrl + 1 em cima do erro para corrigir o problema:
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O Eclipse sugere criar um método getSaldo() na classe Conta. Selecione essa opção, e o método
será inserido automaticamente.

    public Object getSaldo() {
        // TODO Auto-generated method stub
        return null;
    }


Ele gera um método não exatamente como queríamos, pois nem sempre há como o Eclipse ter, de antemão, informações
suficientes para que ele acerte a assinatura do seu método. Modifique o método getSaldo como se mostra a seguir:

    public double getSaldo() {
        return this.saldo;
    }


Esses pequenos recursos do Eclipse são de extrema utilidade. Dessa maneira, você pode programar sem
se preocupar com métodos que ainda não existem, visto que, a qualquer momento, ele pode gerar o
esqueleto (a parte da assinatura do método).

6.6 Executando o main

Rodaremos o método main dessa nossa classe. No Eclipse, clique com o botão direito no arquivo
Principal.java e vá em Run as... Java Application.
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O Eclipse abrirá uma View chamada Console na qual será apresentada a saída do seu programa:
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Quando você precisar rodar de novo, basta clicar no ícone verde de play na toolbar, que rodará o
programa anterior. Ao lado desse ícone, há uma setinha na qual são listados os dez últimos executados.

6.7 Pequenos truques

O Eclipse tem muitos atalhos úteis para o programador. Sem dúvida, os três mais importantes de conhecer
e de praticar são:


	Ctrl + 1 – Aciona o quickfix com sugestões para correção de erros;



	Ctrl + Espaço – Completa códigos;



	Ctrl + 3 – Aciona modo de descoberta de menu. Experimente digitar Ctrl + 3 e depois, ggas e enter.
Ou, então, dê Ctrl + 3 e digite new class.





Você pode ler muito mais detalhes sobre esses atalhos no blog da Caelum:
http://blog.caelum.com.br/as-tres-principais-teclas-de-atalho-do-eclipse/

Existem dezenas de outros. Dentre os mais utilizados pelos desenvolvedores da Caelum, escolhemos os seguintes
para comentar:


	Ctrl + F11 – Roda a última classe que você executou. É o mesmo que clicar no ícone verde que parece um botão de play, localizado na barra de ferramentas.



	Ctrl + PgUp e Ctrl + PgDown – Navegam nas abas abertas. Úteis quando estiver editando vários arquivos ao mesmo tempo.



	Ctrl + Shift + F – Formata o código segundo as convenções do Java.



	Ctrl + M – Expande a View atual para a tela toda (mesmo efeito de dar dois cliques no título da View).



	Ctrl + Shift + L – Exibe todos os atalhos possíveis.



	Ctrl + O – Exibe um outline para rápida navegação.



	Alt + Shift + X e depois J – Roda o main da classe atual. Péssimo para pressionar! Mais fácil você digitar
Ctrl + 3 e depois, Run!. Exagere, desde já, no uso do Ctrl + 3.





Veremos mais atalhos no decorrer do curso, em especial, quando virmos pacotes.


	
		Agora é a melhor hora de aprender algo novo


		
			
		

		Se você está gostando dessa apostila, certamente vai aproveitar os cursos online que lançamos na plataforma Alura. Você estuda a qualquer momento com a qualidade Caelum. Programação, Mobile, Design, Infra, Front-End e Business, entre outros! Ex-estudante da Caelum tem 10% de desconto, siga o link!

		Conheça a Alura Cursos Online.

	


6.8 Exercícios: Eclipse


	Crie o projeto fj11-contas. Você pode usar o atalho Ctrl + n ou, então, ir
 no menu File -> New -> Project... -> Java Project.

	Dentro do projeto fj11-contas, crie a classe Conta.
 Uma conta deve ter as seguintes informações: saldo (double), titular
 (String), numero (int) e agencia (String).
 Na classe Conta, crie os métodos deposita e
 saca como nos capítulos anteriores.
 Crie também uma classe TesteDaConta com o main e instancie uma conta.
 Desta vez, tente exagerar no uso do Ctrl + espaço e Ctrl + 1.

 Por exemplo:

 publ<ctrl espaco> v<ctrl espaco> deposita(do<ctrl espaço> valor){

 Repare que até mesmo nomes de variáveis ele cria para você! Acompanhe as dicas
 do instrutor ou instrutora.

 Muitas vezes, ao criarmos um objeto, nem mesmo declaramos a variável:

 new Conta();


 Vá nessa linha e dê Ctrl + 1. Ele recomendará e declarará a variável
 a você.



	Imagine que queiramos criar um setter do titular para a classe Conta. Dentro
 da classe Conta, digite:

 setTit<ctrl + espaco>

 Outra forma de criar os getters e os setters para os atributos da classe Conta
 é utilizar o atalho Ctrl + 3 e, na caixa de seleção, digitar ggas, iniciais
 de Generate Getters and Setters!

 OBS.: Não crie um setter para o atributo saldo!



	Vá para a classe que tem o main e deixe a tecla CONTROL pressionada enquanto você
 passa o mouse sobre o seu código. Repare que tudo virou hyperlink. Clique em
 um método o qual você está invocando na classe Conta.

 Você pode conseguir o mesmo efeito de abrir o arquivo no qual o método foi
 declarado de uma maneira ainda mais prática: sem usar o mouse. Quando o cursor
 estiver sobre o que você quer analisar, simplesmente, clique em F3.



	Clique com o botão direito em um arquivo no navigator. Escolha
 Compare With -> Local History. O que é esta tela?
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	Use o Ctrl + Shift + F para formatar o seu código. Dessa maneira, o comando
 arrumará a bagunça de espaçamento e enters do seu código.
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	(Opcional) O que são os arquivos .project e .classpath? Leia os seus conteúdos.

 

	(Opcional) Clique com o botão direito no projeto e depois, em propriedades. É uma das telas mais
 importantes do Eclipse, na qual você pode configurar diversas informações para
 o seu projeto, como compilador, versões, formatador e outros.
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6.9 Discussão em aula: Refactoring

Existe um menu no Eclipse chamado Refactor. Ele tem opções bastante interessantes
para auxiliar na alteração de código a fim de melhorar a organização ou clareza. Por
exemplo, uma de suas funcionalidades é tornar possível a mudança do nome de uma variável,
de um método, ou de uma classe, de forma que a alteração (em um lugar só do sistema)
atualize todas as outras vezes que usava o nome antigo.

Usar bons nomes no seu código é um excelente começo para mantê-lo legível e fácil de dar manutenção! Mas o assunto refatoração não para por aí: quebrar métodos grandes em menores, dividir classes grandes em algumas pequenas e mais concisas e melhorar o
encapsulamento, todas essas são formas de refatoração. E esse menu do Eclipse nos
ajuda a fazer várias delas.



        
        

    



        
        
    
    


        
        

    Capítulo 8
Ferramentas: JAR e Javadoc

    
        
        
            "Perder tempo em aprender coisas que não interessam priva-nos de descobrir coisas
interessantes." -- Carlos Drummond de Andrade

Ao final deste capítulo, você será capaz de:


	Criar o JAR do seu aplicativo;

	Colocar um JAR no build path do seu projeto;

	Ler um Javadoc;

	Criar o Javadoc do seu aplicativo.




8.1 Arquivos, bibliotecas e versões

Assim que um programa fica pronto, é meio complicado enviar dezenas ou centenas de classes para cada
cliente que quer utilizá-lo.

O jeito mais simples de trabalhar com um conjunto de classes é compactá-lo em um arquivo só. O
formato de compactação padrão é o ZIP com a extensão do arquivo compactado JAR.


O arquivo .jar

O arquivo JAR, ou Java ARchive, tem um conjunto de classes (e arquivos de
configurações) compactado, no estilo de um arquivo zip. O arquivo jar pode ser
criado com qualquer compactador zip disponível no mercado, inclusive com o programa jar
que vem junto com o JDK.




Para criar um arquivo JAR do nosso programa de banco,
de nome banco.jar, basta ir ao diretório em que
estão contidas as classes dos pacotes
br.com.caelum.util e br.com.caelum.banco e usar o
comando a seguir:

jar -cvf banco.jar br/com/caelum/util/*.class br/com/caelum/banco/*.class

Com o intuito de usar esse arquivo banco.jar para rodar o TesteDoBanco, basta rodar o java com o
arquivo jar como argumento:

java -classpath banco.jar br.com.caelum.contas.main.TesteDoBanco

Para adicionar mais arquivos .jar que podem ser bibliotecas ao programa, basta rodar o Java
da seguinte maneira:

java -classpath biblioteca1.jar;biblioteca2.jar NomeDaClasse

Lembre-se de que o ponto e vírgula utilizado só é válido em ambiente Windows. Em Linux, Mac e outros Unix,
utiliza-se os dois pontos (varia de acordo com o sistema operacional).

Há também um arquivo de manifesto que contém informações do seu JAR como, por exemplo, qual classe
ele rodará quando o JAR for chamado. Mas não se preocupe, pois, com o Eclipse, esse arquivo é
gerado automaticamente.


Bibliotecas

Diversas bibliotecas podem ser controladas de acordo com a versão por estarem sempre compactadas a
um arquivo .jar. Basta verificar o nome da biblioteca (por exemplo log4j-1.2.13.jar) para
descobrir a sua versão.

Então, é possível rodar dois programas ao mesmo tempo, cada um utilizando uma versão da biblioteca
por meio do parâmetro -classpath do Java.





Criando um .jar automaticamente

Existem diversas ferramentas que servem para automatizar o processo de deploy, que consiste em
compilar, gerar documentação, bibliotecas, etc. As duas mais famosas são o ANT e o MAVEN,
ambas são projetos do grupo Apache.

O Eclipse pode gerar facilmente um JAR, porém, se o seu build é complexo e precisa preparar e copiar
uma série de recursos, as ferramentas indicadas acima têm sofisticadas maneiras de rodar um
script batch.






	
		Você pode também fazer o curso data dessa apostila na Caelum


		
			
		

		Querendo aprender ainda mais sobre? Esclarecer dúvidas dos exercícios? Ouvir explicações detalhadas com um instrutor?
A Caelum oferece o curso data presencial nas cidades de São Paulo, Rio de Janeiro e Brasília, além de turmas incompany.

		Consulte as vantagens do curso Java e Orientação a Objetos

	


8.2 Gerando o JAR pelo Eclipse

Neste exemplo, geraremos o arquivo JAR do nosso projeto a partir do Eclipse:


	Clique com o botão direito em cima do nome do seu projeto e selecione a opção Export.

[image: ]



	Na tela Export (como mostra a figura abaixo), selecione a opção JAR file e aperte o botão Next.
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	Na opção JAR file, selecione o local em que você deseja salvar o arquivo JAR e aperte Next.
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	Na próxima tela, simplesmente clique em Next, pois não há nenhuma configuração a ser feita.



	Na tela abaixo, na opção select the class of the application entry point, você deve escolher
qual classe será a que rodará automaticamente quando você executar o JAR.
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	Entre na linha de comando: java -jar banco.jar





É comum dar um nome mais significativo aos JARs, incluindo nome da empresa,
do projeto e versão, como caelum-banco-1.0.jar.

8.3 Javadoc

Como saberemos o que cada classe tem no Java? Quais são seus métodos, o que eles fazem?

E, a partir da internet, você pode acessar por meio do link:
http://download.java.net/jdk8/docs/api/index.html

No site da Oracle, você pode (e deve) baixar a documentação das bibliotecas do Java, frequentemente
referida como Javadoc ou API (sendo na verdade a documentação da API).
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Nessa documentação, no quadro superior esquerdo, você encontra os pacotes e, no inferior esquerdo,
está a listagem das classes e interfaces do respectivo pacote (ou de todos, caso nenhum tenha sido
especificado). Ao clicar em uma classe ou interface, o quadro da direita passa a detalhar todos
atributos e métodos.

Repare que métodos e atributos privados não estão aí. O importante é documentar o que sua classe faz,
e não como ela o faz: detalhes de implementação, como atributos e métodos privados, não interessam as pessoas
desenvolvedoras que usarão a sua biblioteca (ou, ao menos, não deveriam interessá-las).

Você também consegue gerar esse Javadoc a partir da linha de comando digitando: javadoc.

8.4 Gerando o Javadoc

Para gerar o Javadoc a partir do Eclipse, é muito simples. Siga os passos abaixo:


	Na barra de menu, selecione o menu Project e, depois, a opção Generate Javadoc... (disponível apenas se estiver na perspectiva Java, mas você pode acessar o mesmo Wizard pelo export do
projeto).
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	Em seguida, aparecerão as opções para gerar a documentação do seu sistema. Selecione todas as
classes do seu sistema e deixe as outras opções como estão. Não esqueça de marcar o caminho da opção
Destination, pois é lá que estará sua documentação.
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	Abra a documentação por meio do caminho que você marcou e abra o arquivo index.html, o qual chamará
uma página semelhante a essa da figura abaixo.
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Para colocarmos comentários na documentação, devemos adicionar o texto ao código sob forma de comentário,
abrindo-o com /** e fechando-o com */ e, nas outras linhas, apenas colocando *.
Também podemos definir outras informações nesse texto, como: autor, versão, parâmetros, retorno, etc.
Adicione alguns comentários ao seu projeto como abaixo:

    /**
     * Classe responsável por moldar as Contas do Banco
     *
     * @author Manoel Santos da Silva
     */

    public class Conta{
        ...
    }


Ou adicione alguns comentários em algum método seu:

    /**
     * Metodo que incrementa o saldo.
     * @param valor
     */

    public void deposita(double valor) {
        ...
    }


Veja como ficou:



[image: ]


	
		Seus livros de tecnologia parecem do século passado?


		
			
		

		Conheça a Casa do Código, uma nova editora, com autores de destaque no mercado, foco em ebooks (PDF, epub, mobi), preços imbatíveis e assuntos atuais.
Com a curadoria da Caelum e excelentes autores, é uma abordagem diferente para livros de tecnologia no Brasil.

		Casa do Código, Livros de Tecnologia.

	


8.5 Exercícios: JAR e Javadoc


	Gere um JAR do seu sistema com o arquivo de manifesto. Execute-o com java -jar:

 java -jar caelum-banco-1.0.jar

 Se o Windows ou o Linux foi configurado para trabalhar com a extensão .jar, basta você dar
 um duplo clique no arquivo que ele será executado (o arquivo Manifest será lido para que
 este descubra qual é a classe com main que o Java deve processar).



	Gere o Javadoc do seu sistema. Para isso, vá ao menu Project e, depois, à opção Generate
 Javadoc se estiver na perspectiva Java. Se não, dê um clique com o botão direito no seu
 projeto, escolha Export, depois, javadoc e siga o procedimento descrito na última seção
 deste capítulo.

 Independente da perspectiva que utilizar no Eclipse, você também pode usar o Ctrl + 3 e
 começar a escrever Javadoc até que a opção de exportar o Javadoc apareça.






Interface versus implementação novamente!

Repare que a documentação gerada não mostra o conteúdo dos métodos 
nem atributos e métodos privados! Isso faz parte da implementação, e o que
importa para quem usa uma biblioteca é a interface: o que ela faz.




8.6 Importando um JAR externo

Já sabemos como documentar nosso projeto e gerar um JAR para distribuí-lo, mas ele ainda não tem uma interface gráfica do usuário. Se quisermos rodar o nosso sistema, temos de executá-lo pelo terminal com os valores hard-coded. Seria mais interessante se tivéssemos uma interface mais amigável para que o usuário pudesse interagir com o nosso sistema. Ao mesmo tempo, não queremos nos preocupar nesse momento em criar todas as classes a fim de representar essa interface gráfica, queremos apenas utilizar algo já pronto.

Para isso, importaremos uma biblioteca externa. O próprio Eclipse já nos dá suporte para a importação de JARs. Para fazer isso, basta ir no menu Project -> Properties, selecionar a opção Java Build Path, depois selecionar a aba Libraries e, finalmente, clicar no botão Add External Jars.... Agora é só selecionar o JAR a ser importado e clicar em Open. Aperte em Ok novamente para fechar a janela de importação e pronto! Nossa biblioteca já está disponível para ser utilizada.

8.7 Exercícios: Importando um JAR


	Importemos um JAR que contém a interface gráfica do usuário para o nosso sistema de contas.


	Vá no menu Project -> Properties;

	Selecione a opção Java Build Path;

	Selecione a aba Libraries;
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	Clique no botão Add External Jars...;



	Selecione o arquivo fj11-lib-contas.jar localizado na pasta dos arquivos dos cursos/11;




	Clique no botão Ok para fechar a janela de importação.







	Para verificarmos se a importação deu certo, chamaremos uma classe da biblioteca importada para exibir uma janela de boas-vindas.

 Crie uma classe TestaJar no pacote br.com.caelum.contas.main.

 Crie também o método main.



	Dentro do método criado, invocaremos o método main da classe OlaMundo, que existe no JAR importado. Seu código deve ficar dessa maneira:

package br.com.caelum.contas.main;

import br.com.caelum.javafx.api.main.OlaMundo;

public class TestaJar {

 public static void main(String[] args) {
     OlaMundo.main(args);
 }
}


 Não esqueça de importar a classe OlaMundo do pacote br.com.caelum.javafx.api.main. Use o atalho Ctrl + shift + O.



	Execute a sua aplicação e veja se apareceu uma janela de boas-vindas como a seguinte:
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8.8 Manipulando a conta pela interface gráfica

Agora que já importamos o JAR que contém a interface gráfica, daremos uma olhada na
primeira tela do nosso sistema:
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Nessa tela, percebemos que temos botões para as ações de criação de conta, saque
e depósito, os quais devem utilizar a implementação existente em nossa classe Conta.

Se quisermos visualizar a tela, podemos criar um main que chamará a classe
TelaDeContas responsável pela sua exibição:

package br.com.caelum.contas.main;

import br.com.caelum.javafx.api.main.TelaDeContas;

public class TestaContas {

    public static void main(String[] args) {
        TelaDeContas.main(args);
    }
}


Ao executarmos a aplicação, ocorrerá um erro:
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Mas por que esse erro ocorreu? A tela precisa conhecer alguém que saiba
executar as ações de saque e depósito na conta e que consiga buscar os dados da tela
para popular a conta. Como não temos ninguém para fazer isso ainda, ocorreu o erro.

Então, criaremos a classe ManipuladorDeContas, que será responsável por fazer esta "ponte" entre a
tela e a classe de Conta:

package br.com.caelum.contas;

public class ManipuladorDeContas {

}


Agora, ao executarmos a aplicação, veremos que a tela aparece com sucesso:
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E se tentarmos clicar no botão de criação de conta? Também ocorre um erro!
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Dessa vez, o erro indica que falta o método criaConta dentro da classe
ManipuladorDeContas. Vamos, então, criá-lo:

public class ManipuladorDeContas {

    public void criaConta(){
        Conta conta = new Conta();
        conta.setAgencia("1234");
        conta.setNumero(56789);
        conta.setTitular("Batman");
    }
}


Para conseguirmos obter as informações da tela, todos os
métodos que criaremos precisam receber um parâmetro do tipo Evento, o qual conterá as
informações digitadas. Apesar de não utilizarmos esse parâmetro, precisamos recebê-lo.

import br.com.caelum.javafx.api.util.Evento;

public class ManipuladorDeContas {

    public void criaConta(Evento evento){
        Conta conta = new Conta();
        conta.setAgencia("1234");
        conta.setNumero(56789);
        conta.setTitular("Batman");
    }
}


Se tentarmos executar a aplicação e clicar no botão Criar conta, veremos que não
ocorrerá mais nenhum erro, mas, ao mesmo tempo, os dados da conta não são populados na tela.
Isso acontece pois a variável conta é apenas local, ou seja, ela só existe dentro
do método criaConta. Além disso, se quiséssemos depositar um valor na conta, em
qual conta depositaríamos? Ela não é visível para nenhum outro método!

Precisamos que essa variável seja um atributo do ManipuladorDeContas. Vamos
alterá-la:

import br.com.caelum.javafx.api.util.Evento;

public class ManipuladorDeContas {

    private Conta conta;

    public void criaConta(Evento evento){
        this.conta = new Conta();
        this.conta.setAgencia("1234");
        this.conta.setNumero(56789);
        this.conta.setTitular("Batman");
    }
}


Testando agora, conseguimos ver os dados da conta na tela!
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Só falta criarmos os métodos saca e deposita. Começaremos implementando o
método deposita. Nele precisamos do valor digitado pelo usuário na tela, e é para
isso que serve a classe Evento. Se quisermos buscar um valor do tipo double,
podemos invocar o método double passando o nome do campo que queremos recuperar
como parâmetro. Com o valor em mãos, podemos, então, passá-lo ao método desejado.
Nosso método fica:

import br.com.caelum.javafx.api.util.Evento;

public class ManipuladorDeContas {

    // ...

    public void deposita(Evento evento){
        double valorDigitado = evento.getDouble("valor");
        this.conta.deposita(valorDigitado);
    }
}


Podemos fazer a mesma coisa para o método saca:

import br.com.caelum.javafx.api.util.Evento;

public class ManipuladorDeContas {

    // ...

    public void deposita(Evento evento){
        double valorDigitado = evento.getDouble("valor");
        this.conta.deposita(valorDigitado);
    }

    public void saca(Evento evento){
        double valorDigitado = evento.getDouble("valor");
        this.conta.saca(valorDigitado);
    }
}


Agora conseguimos rodar a aplicação e, em seguida, clicar nos botões de saque e depósito que o saldo
é atualizado com sucesso!
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8.9 Exercícios: mostrando os dados da conta na tela


	Crie a classe ManipuladorDeContas dentro do pacote br.com.caelum.contas. Repare
 que os pacotes br.com.caelum.contas.main e br.com.caelum.contas.modelo são
 subpacotes do pacote br.com.caelum.contas, portanto o pacote br.com.caelum.contas
 já existe. Para criar a classe neste pacote, basta selecioná-lo na janela de criação
 da classe:
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 A classe ManipuladorDeContas fará a ligação da Conta com a tela, por isso precisaremos
 declarar um atributo do tipo Conta.

 


	Na classe ManipuladorDeContas, crie o método criaConta que recebe como parâmetro um objeto do tipo Evento.
 Instancie uma conta para o atributo conta e coloque os valores de numero,
 agencia e titular. 



	Com a conta instanciada, agora podemos implementar as funcionalidades de saque e
 depósito. Crie o método deposita, que recebe um Evento, classe que
 retorna os dados da tela nos tipos que precisamos. Por exemplo, se quisermos o
 valor a depositar, sabemos que ele é do tipo double e que o nome do campo na
 tela é valor .

 Dica: a  classe Evento tem o  método getDouble(), que retorna o conteúdo desse campo. Então, use getDouble(“valor”) quando precisar obter o conteúdo do campo valor.






	Crie agora o método saca. Ele também deve receber um Evento nos mesmos
 moldes do deposita.

 

	Precisamos agora testar nossa aplicação. Crie a classe TestaContas dentro do
 pacote br.com.caelum.contas com um main. Nela importaremos o main da
 classe TelaDeContas, que mostrará a tela de nosso sistema. Não se esqueça de
 fazer o import dessa classe!

 Dica: para executar a tela da nossa aplicação, o método estático main da classe TelaDeContas deve ser invocado dentro do método main da classe TestaContas que você está criando agora.

 Rode a aplicação, crie a conta e tente fazer as operações de saque e depósito. Tudo
 deve funcionar normalmente.






        
        

    



        
        
    
    


        
        

    Capítulo 11
Interfaces

    
        
        
            "Uma imagem vale mil palavras. Uma interface vale mil imagens." -- Ben Shneiderman

Ao final deste capítulo, você será capaz de:


	Dizer o que é uma interface e as diferenças entre herança e implementação;

	Escrever uma interface em Java;

	Utilizá-las como um poderoso recurso para diminuir acoplamento entre as classes.




11.1 Aumentando nosso exemplo


Imagine que um sistema de controle do banco possa ser acessado pelos
diretores do banco, além dos gerentes. Então, teríamos uma classe Diretor:

public class Diretor extends Funcionario {

    public boolean autentica(int senha) {
        // Verificar aqui se a senha confere com a recebida como parâmetro.
    }

}


E a classe Gerente:

public class Gerente extends Funcionario {

    public boolean autentica(int senha) {
        // Verificar aqui se a senha confere com a recebida como parâmetro.
        // No caso do gerente, conferir também se o departamento dele
        // tem acesso.
    }

}
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Repare que o método de autenticação de cada tipo de Funcionario pode variar muito. Mas vamos aos
problemas. Considere o SistemaInterno e seu controle: precisamos receber um Diretor ou
Gerente como argumento, verificar se ele se autentica e colocá-lo dentro do sistema.

public class SistemaInterno {

    public void login(Funcionario funcionario) {
        // Invocar o método autentica?
        // Não dá! Nem todo Funcionario o tem.
    }
}


O SistemaInterno aceita qualquer tipo de Funcionario, tendo ele acesso ao sistema ou não, mas
note que nem todo Funcionario tem o método autentica. Isso nos impede de chamar esse
método com uma referência apenas a Funcionario (haveria um erro de compilação). O que fazer,
então?

public class SistemaInterno {

    public void login(Funcionario funcionario) {
        funcionario.autentica(...); // não compila
    }
}


Uma possibilidade é criar dois métodos login no SistemaInterno: um para receber Diretor, e
outro, Gerente. Já vimos que essa não é uma boa escolha. Por quê?

public class SistemaInterno {

    // design problemático
    public void login(Diretor funcionario) {
        funcionario.autentica(...);
    }

    // design problemático
    public void login(Gerente funcionario) {
        funcionario.autentica(...);
    }

}


Cada vez que criarmos uma nova classe de Funcionario que é autenticável, precisaríamos
adicionar um novo método de login no SistemaInterno.


Métodos com mesmo nome

Em Java, métodos podem ter o mesmo nome desde que não sejam ambíguos, isto é, que exista uma maneira
de distingui-los no momento da chamada.

Isso se chama sobrecarga de método. (Overloading. Não confundir com overriding, que é um
conceito muito mais poderoso).




Uma solução mais interessante seria criar uma classe no meio da árvore de herança,
FuncionarioAutenticavel:

public class FuncionarioAutenticavel extends Funcionario {

    public boolean autentica(int senha) {
        // Faz autenticação padrão.
    }

    // Outros atributos e métodos.

}


As classes Diretor e Gerente passariam a estender de FuncionarioAutenticavel, e o
SistemaInterno receberia referências desse tipo, como se mostra a seguir:

public class SistemaInterno {

    public void login(FuncionarioAutenticavel fa) {

        int senha = //Pega senha de um lugar ou de um scanner de polegar.

        // Aqui eu posso chamar o autentica!
        // Pois, todo FuncionarioAutenticavel o tem.
        boolean ok = fa.autentica(senha);

    }
}
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Repare que FuncionarioAutenticavel é um forte candidato à classe abstrata. Além disso, o método
autentica ainda poderia ser um método abstrato.

O uso de herança resolve esse caso, mas vamos a uma outra situação um pouco mais complexa: precisamos
que todos os clientes também tenham acesso ao SistemaInterno. O que fazer? Uma opção é criar
outro método login em SistemaInterno, mas já descartamos essa possibilidade anteriormente.

Uma outra opção que é comum entre os novatos é fazer uma herança sem sentido para resolver o problema,
por exemplo, fazer Cliente extends FuncionarioAutenticavel. Realmente resolve o problema, mas
trará diversos outros. Cliente definitivamente não é FuncionarioAutenticavel. Se você
fizer isso, o Cliente terá, por exemplo, um método getBonificacao, um atributo salário e
outros membros que não fazem o menor sentido para essa classe. Não faça herança caso a relação não
seja estritamente "é um".
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Como resolver essa situação? Note que conhecer a sintaxe da linguagem não é o suficiente, precisamos
estruturar/desenhar bem a nossa estrutura de classes.
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11.2 Interfaces

O que precisamos para resolver nosso problema? Arranjar uma forma de poder referenciar Diretor,
Gerente e Cliente de uma mesma maneira, isto é, achar um fator comum.

Se houvesse uma forma na qual essas classes garantissem a existência de um determinado método
por meio de um contrato, resolveríamos o problema.

Toda classe define dois itens:


	O que uma classe faz (as assinaturas dos métodos);

	Como uma classe faz essas tarefas (o corpo dos métodos e atributos privados).



Podemos criar um "contrato" o qual define tudo o que uma classe deve fazer se quiser ter um determinado
status. Imagine:

contrato "Autenticavel":

        Quem quiser ser "Autenticavel" precisa saber:
            1. Autenticar uma senha, devolvendo um booleano.

Quem quiser pode assinar esse contrato, sendo, assim, obrigado a explicar como será feita essa
autenticação. A vantagem é que, se um Gerente assinar esse contrato, podemos nos referenciar a
um Gerente como um Autenticavel.

Podemos criar esse contrato em Java!

public interface Autenticavel {

    boolean autentica(int senha);

}


Chama-se interface, pois é a maneira pela qual poderemos conversar com um Autenticavel.
Interface é a maneira por meio da qual conversamos com um objeto.

Lemos a interface da seguinte maneira: "quem desejar ser Autenticavel precisa saber autenticar recebendo
um inteiro e retornando um booleano". Ela é um contrato que quem assina se responsabiliza
por implementar esses métodos (cumprir o contrato).

Pela ideia base de uma interface, ela pode definir uma série de métodos, mas nunca conter suas implementações. Ela só expõe
o que o objeto deve fazer, e não como ele o faz, nem o que ele tem. Como ele o faz
será definido em uma implementação dessa interface.

E o Gerente pode "assinar" o contrato, ou seja, implementar a interface. No momento em que
ele implementa essa interface, precisa escrever os métodos pedidos por ela (muito parecido
com o efeito de herdar métodos abstratos, aliás, métodos de uma interface são públicos e abstratos
sempre). Para implementar, usamos a palavra-chave implements na classe:

public class Gerente extends Funcionario implements Autenticavel {

    private int senha;

    // Outros atributos e métodos.

    public boolean autentica(int senha) {
        if(this.senha != senha) {
            return false;
        }
        // Pode fazer outras possíveis verificações como saber se esse
        // departamento do gerente tem acesso ao Sistema.

        return true;
    }

}



[image: ]

O implements pode ser lido da seguinte maneira: "a classe Gerente se compromete a ser tratada
como Autenticavel, sendo obrigada a ter os métodos necessários, definidos neste contrato".


A partir de agora, podemos tratar um Gerente como sendo um Autenticavel. Ganhamos mais
polimorfismo! Temos mais uma forma de referenciar a um Gerente. Quando crio uma variável do tipo
Autenticavel, estou criando uma referência a qualquer objeto de uma classe que implemente
Autenticavel, direta ou indiretamente:

Autenticavel a = new Gerente();
// Posso aqui chamar o método autentica!


Novamente, a utilização mais comum seria receber por argumento, como no nosso SistemaInterno:

public class SistemaInterno {

  public void login(Autenticavel a) {
     int senha = // Pega senha de um lugar ou de um scanner de polegar.
     boolean ok =    a.autentica(senha);

     // Aqui eu posso chamar o autentica!
     // Não necessariamente é um Funcionario!
     // Além do mais, eu não sei que objeto a
     // referência "a" está apontando exatamente! Flexibilidade.
  }

}


Pronto! E já podemos passar qualquer Autenticavel para o SistemaInterno. Então, precisamos
fazer com que o Diretor também implemente essa interface.

public class Diretor extends Funcionario implements Autenticavel {

    // Métodos e atributos devem obrigatoriamente ter o autentica.

}
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Podemos passar um Diretor. No dia em que tivermos mais um funcionário com acesso ao
sistema, bastará que ele implemente essa interface para se encaixar no sistema.

Qualquer Autenticavel passado ao SistemaInterno está bom para nós. Repare que pouco
importa quem o objeto referenciado realmente é, pois ele tem um método autentica o qual é 
necessário para nosso SistemaInterno funcionar corretamente. Aliás, qualquer outra classe que
futuramente implemente essa interface poderá ser passada como argumento aqui.

Autenticavel diretor = new Diretor();
Autenticavel gerente = new Gerente();


Ou, se achamos que o Fornecedor precisa ter acesso, ele só precisará implementar
Autenticavel. Olhe só o tamanho do desacoplamento: quem escreveu o SistemaInterno necessita somente
saber que ele é Autenticavel.

public class SistemaInterno {

  public void login(Autenticavel a) {
    // Não importa se ele é um gerente ou diretor,
    // será que é um fornecedor?
    // Eu, o programador do SistemaInterno, não me preocupo.
    // Invocarei o método autentica.
  }

}


Não faz diferença se é um Diretor, Gerente, Cliente ou qualquer classe que venha por aí.
Basta seguir o contrato! Além do mais, cada Autenticavel pode se autenticar de uma maneira
completamente diferente de outro.

Lembre-se: a interface define que todos saberão se autenticar (o que ele faz), enquanto a
implementação define como exatamente será feito (de que forma ele faz).

A maneira pela qual os objetos se comunicam em um sistema orientado a objetos é muito mais importante do que
como eles executam. O que um objeto faz é mais importante do que como ele o faz. Aqueles que
seguem essa regra terão sistemas mais fáceis de manter e modificar. Conforme você já percebeu, essa é
uma das ideias principais que queremos passar e, provavelmente, a mais importante de todo esse curso.


Mais sobre interfaces: herança e métodos default

Diferentemente das classes, uma interface pode herdar de mais de uma interface. É como um contrato
o qual depende que outros contratos sejam fechados antes daquele valer. Você não herda métodos e
atributos, mas, sim, responsabilidades.

Um outro recurso em interfaces são os métodos default a partir do Java 8. Você pode, sim, declarar um método concreto utilizando a palavra default ao lado, e suas implementações não precisam necessariamente reescrevê-lo. Veremos que isso acontece, por exemplo, com o método List.sort durante o capítulo de coleções. É um truque muito utilizado para poder evoluir uma interface sem quebrar compatibilidade com as implementações anteriores.




11.3 Dificuldade no aprendizado de interfaces

Interfaces representam uma barreira no aprendizado do Java: parece que estamos escrevendo um código
o qual não serve para nada, uma vez que teremos essa linha (a assinatura do método) escrita nas nossas classes
implementadoras. Essa é uma maneira errada de se pensar. O objetivo do uso de uma interface é deixar
seu código mais flexível e possibilitar a mudança de implementação sem maiores traumas. Não é
apenas um código de prototipação ou um cabeçalho!

Os mais radicais dizem que toda classe deve ser interfaceada, isto é, só devemos nos referir a
objetos por intermédio das suas interfaces. Se determinada classe não tem uma interface, ela deveria tê-la.
Os autores deste material acham tal medida radical demais, porém o uso de interfaces em vez de
herança é amplamente aconselhado. Você pode encontrar mais informações sobre o assunto nos livros
Design Patterns, Refactoring e Effective Java.

No livro Design Patterns, logo no início, os autores citam duas regras de ouro. Uma é: "evite herança,
prefira composição", e a outra: "programe voltado à interface, e não à implementação".

Veremos o uso de interfaces no capítulo de coleções, o que melhorará o entendimento do assunto. O
exemplo da interface Comparable também é muito esclarecedor, no qual enxergamos o reaproveitamento
de código mediante as interfaces, além do encapsulamento. Para o método Collections.sort(), pouco
importa quem será passado como argumento, pois basta que a coleção seja de objetos
comparáveis. Ele pode ordenar Elefante, Conexao ou ContaCorrente, desde que implementem
Comparable.

11.4 Exemplo interessante: conexões com o banco de dados

Como fazer com que todas as chamadas para bancos de dados diferentes respeitem a mesma regra? Usando
interfaces!

Imagine uma interface Conexao contendo todos os métodos necessários à comunicação e troca de
dados com um banco de dados. Cada banco de dados fica encarregado de criar a sua implementação para
essa interface.

Quem for usar uma Conexao não precisa se importar com qual objeto exatamente está trabalhando, posto
que ele cumprirá o papel que toda Conexao deve ter. Não importa se é uma conexão com um Oracle
ou MySQL.
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Apesar do java.sql.Connection não trabalhar bem assim, a ideia é muito similar. Porém, as conexões
vêm de uma factory chamada DriverManager.

Conexão a banco de dados está fora do escopo desse treinamento, mas é um dos primeiros tópicos
abordados no curso FJ-21 juntamente com DAO.


Um pouco mais...


	Posso substituir toda minha herança por interfaces? Qual é a vantagem e a
desvantagem?
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11.5 Exercícios: interfaces


	Nosso banco precisa tributar dinheiro de alguns bens que nossos clientes possuem.
 Para isso, criaremos uma interface no pacote br.com.caelum.contas.modelo do nosso projeto
  fj11-contas já existente:

 • O nome da interface deverá ser Tributavel;

 • Deverá ter um único método chamado  getValorImposto(), que não recebe nada e devolve um double.

 Lemos essa interface da seguinte maneira: "todos que quiserem ser tributável
 precisam saber retornar o valor do imposto, devolvendo um double".

 Alguns bens são tributáveis e outros não. ContaPoupanca não é tributável,
 já para ContaCorrente, você precisa pagar 1% da conta, e o SeguroDeVida
 tem uma taxa fixa de 42 reais mais 2% do valor do seguro.

 Assim, para atender a essa nova necessidade, você deve:


	Alterar a classe ContaCorrente;

	Criar a classe SeguroDeVida . 

A classe SeguroDeVida deverá estar no pacote br.com.caelum.contas.modelo e ter os seguintes atributos encapsulados: valor (do tipo double), titular (do tipo String) e numeroApolice (do tipo int).

Dica: na classe SeguroDeVida, lembre-se de escrever o método  getTipo  para que o tipo do produto apareça na interface gráfica.







	Criaremos a classe ManipuladorDeSeguroDeVida dentro do pacote
br.com.caelum.contas para vincular a classe SeguroDeVida à tela de criação
de seguros. Aquela classe deve ter um atributo do tipo SeguroDeVida.

Deve ter também o método criaSeguro, que não retorna nada e deve receber um parâmetro do tipo
Evento para conseguir obter os dados da tela. Use os seguintes métodos da classe Evento a fim de pegar estes dados:


	evento.getInt("numeroApolice"));

	evento.getString("titular"));

	evento.getDouble("valor"));



Dica: use os métodos setters da classe SeguroDeVida para guardar as informações obtidas. Exemplo:

this.seguroDeVida.setNumeroApolice(evento.getInt("numeroApolice"));




	Execute a classe TestaContas e tente cadastrar um novo seguro de vida. O seguro
 cadastrado deve aparecer na tabela de seguros de vida.



	Queremos saber qual o valor total dos impostos de todos os tributáveis.
 Então criemos a classe ManipuladorDeTributaveis dentro do pacote
 br.com.caelum.contas.
 Crie também o método calculaImpostos, que não retorna nada e recebe um parâmetro do tipo Evento. Mais pra frente preencheremos o corpo desse método.

 Essa classe também deverá ter o atributo encapsulado total do tipo double.



	Agora que criamos o tributável, habilitaremos a última aba de nosso sistema. Altere
 a classe TestaContas para passar o valor true na chamada do método
 mostraTela.

   Observe: agora que temos o seguro de vida funcionando, a tela de relatório já
 consegue imprimir o valor dos impostos individuais de cada tipo de Tributavel.



	No método calculaImpostos da classe ManipuladorDeTributaveis, precisamos buscar os valores de impostos de cada Tributavel,
 somá-los e atribuí-los ao atributo total. Para isso, usaremos os seguintes métodos da classe  Evento:


	getTamanhoDaLista que deve receber o nome da lista desejada, nesse caso, "listaTributaveis". Esse método retorna a quantidade de tributáveis:

evento.getTamanhoDaLista("listaTributaveis");




	getTributavel retorna um Tributavel de uma
determinada posição de uma lista, em que precisamos passar o nome da lista e o índice
do elemento:

evento.getTributavel("listaTributaveis", i);


Dica: utilize o comando for para percorrer a lista inteira, passando por cada posição.

Por fim, o método calculaImpostos deverá invocar o método getValorImposto() e acumular o valor do imposto de todos os tributáveis no atributo total:

total += t.getValorImposto();


Repare que, de dentro do ManipuladorDeTributaveis, você não pode acessar
o método getSaldo, por exemplo, pois não há a garantia de que o
Tributavel a ser passado como argumento tenha esse método. A única
certeza é a de que esse objeto tem os métodos declarados na
interface Tributavel.

É interessante enxergar que as interfaces (como nesse caso, Tributavel)
costumam ligar classes muito distintas, unindo-as por uma característica que elas
têm em comum. No nosso exemplo, SeguroDeVida e ContaCorrente são
entidades completamente distintas, porém ambas possuem a característica de serem
tributáveis.

Se amanhã o governo começar a tributar até mesmo PlanoDeCapitalizacao, basta
que essa classe implemente a interface Tributavel! Repare no grau de
desacoplamento que temos: a classe GerenciadorDeImpostoDeRenda nem imagina
que trabalhará como  PlanoDeCapitalizacao. Para ela, o único fato
importante é que o objeto respeite o contrato de um tributável, isto é, a interface
Tributavel. Novamente: programe voltado à interface, não à implementação.

Quais os benefícios de manter o código com baixo acoplamento?







	(Opcional) Crie a classe TestaTributavel com um método main para testar
 o nosso exemplo:

 public class TestaTributavel {

     public static void main(String[] args) {
         ContaCorrente cc = new ContaCorrente();
         cc.deposita(100);
         System.out.println(cc.getValorImposto());

         // testando polimorfismo:
         Tributavel t = cc;
         System.out.println(t.getValorImposto());
     }
 }


 Tente chamar o método getSaldo por meio da referência t. O que ocorre?
 Por quê?

 A linha em que atribuímos cc a um Tributavel é apenas para você enxergar
 que é possível fazê-lo. Nesse nosso caso, isso não tem uma utilidade. Essa
 possibilidade foi útil no exercício anterior.

 
 




11.6 Exercícios opcionais

Atenção: caso você resolva esse exercício, faça-o em um projeto à parte
conta-interface, uma vez que usaremos a Conta como classe em exercícios futuros.


	(Opcional) Transforme a classe Conta em uma interface.

 
 public interface Conta {
     public double getSaldo();
     public void deposita(double valor);
     public void saca(double valor);
     public void atualiza(double taxaSelic);
 }


 Adapte ContaCorrente e ContaPoupanca a essa modificação:

 public class ContaCorrente implements Conta {
     // ...
 }


 public class ContaPoupanca implements Conta {
     // ...
 }


 Algum código terá de ser copiado e colado? Isso é tão ruim?

 

	(Opcional) Às vezes, é interessante criarmos uma interface que herde de outras
 interfaces: aquela é chamada de subinterface, e nada mais é do que um
 agrupamento de obrigações para a classe que a implementar.

 public interface ContaTributavel extends Conta, Tributavel {
 }


 Dessa maneira, quem for implementar essa nova interface precisa implementar todos
 os métodos herdados das suas superinterfaces (e talvez ainda novos métodos
 declarados dentro dela):

 public class ContaCorrente implements ContaTributavel {
   // métodos
 }

 Conta c = new ContaCorrente();
 Tributavel t = new ContaCorrente();


 Repare que o código pode parecer estranho, pois a interface não declara método
 algum, só herda os métodos abstratos declarados nas outras interfaces.

 Ao mesmo tempo que uma interface pode herdar de mais de uma outra interface,
 classes só podem ter uma classe mãe (herança simples).

 




11.7 Discussão: favoreça composição em relação à herança

Discuta com o seu instrutor e colegas alternativas à herança. Falaremos
de herança versus composição, além de o porquê da herança ser, muitas vezes, considerada
maléfica.

Em uma entrevista, James Gosling, pai do Java, fala sobre uma linguagem
puramente de delegação e chega a dizer:

Rather than subclassing, just use pure interfaces.
It's not so much that class inheritance is particularly bad. It just
has problems.

(Tradução livre: "Em vez de fazer subclasses, use simplesmente interfaces. Não é que a herança de classes seja particularmente ruim. Ela só tem problemas.")

http://www.artima.com/intv/gosling3P.html

No blog da Caelum, há também um post sobre o assunto:
http://blog.caelum.com.br/2006/10/14/como-nao-aprender-orientacao-a-objetos-heranca/
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    Capítulo 12
Exceções e Controle de Erros

    
        
        
            "Quem pensa pouco erra muito."--Leonardo da Vinci

Ao final deste capítulo, você será capaz de:


	Controlar erros e tomar decisões com base neles;

	Criar novos tipos de erros para melhorar o tratamento deles em sua aplicação ou biblioteca;

	Assegurar que um método funcionou como diz em seu contrato.



12.1 Motivação


Voltando às Contas que criamos no capítulo 6, o que aconteceria ao tentar chamar o método
saca com um valor fora do limite? O sistema mostraria uma mensagem de erro, mas quem chamou o
método saca não saberá que isso aconteceu.

Como avisar aquele que chamou o método de que este não conseguiu fazer aquilo que deveria?

Em Java, os métodos dizem qual o contrato que eles devem seguir. Se, ao tentar sacar, ele não
consegue fazer o que deveria, ele precisa, ao menos, avisar ao usuário que o saque não foi feito.

Veja no exemplo abaixo, estamos forçando uma Conta a ter um valor negativo, isto é, a estar em um
estado inconsistente de acordo com a nossa modelagem:

Conta minhaConta = new Conta();
minhaConta.deposita(100);
minhaConta.setLimite(100);
minhaConta.saca(1000);
//     o saldo é -900? É 100? É 0? A chamada ao método saca funcionou?


Em sistemas de verdade, é muito comum que quem saiba tratar o erro seja aquele que chamou o método, e não
a própria classe! Portanto, nada mais natural do que a classe sinalizar que um erro ocorreu.

A solução mais simples utilizada antigamente é a de marcar o retorno de um método como boolean e
retornar true se tudo ocorreu da maneira planejada, ou false, caso contrário:

boolean saca(double quantidade) {
    // posso sacar até saldo+limite
    if (quantidade > this.saldo + this.limite) { 
            System.out.println("Não posso sacar fora do limite!");
            return false;
        } else {
            this.saldo = this.saldo - quantidade;
            return true;
        }
    }


Um novo exemplo de chamada do método acima:

Conta minhaConta = new Conta();
minhaConta.deposita(100);
minhaConta.setLimite(100);
if (!minhaConta.saca(1000)) {
    System.out.println("Não saquei");
}


Repare que tivemos de lembrar de testar o retorno do método, mas não somos obrigados a
fazer isso. Esquecer de testar o seu retorno teria consequências drásticas: a
máquina de autoatendimento poderia vir a liberar a quantia desejada de dinheiro, mesmo
que o sistema não tivesse conseguido efetuar o método saca com sucesso, como no
exemplo a seguir:

        Conta minhaConta = new Conta();
        minhaConta.deposita(100);

        // ...
        double valor = 5000;
        minhaConta.saca(valor); // vai retornar false, mas ninguém verifica!
        caixaEletronico.emite(valor);


Mesmo invocando o método e tratando o retorno de maneira correta, o que faríamos se fosse
necessário sinalizar quando o usuário passou um valor negativo como quantidade?
Uma solução seria alterar o retorno de boolean para int e retornar o código do erro que ocorreu.
Isso é considerado uma má prática (conhecida também como uso de magic numbers).

Há várias questões: o retorno do método é perdido, o valor devolvido é mágico e só legível perante extensa
documentação, a pessoa programadora não é obrigada a tratar esse retorno e, se por acaso esquecê-lo,
o programa continuará rodando em um estado inconsistente.

Repare o que aconteceria se fosse necessário retornar um outro valor. O exemplo abaixo mostra um caso
no qual, por intermédio do retorno, não será possível descobrir se ocorreu um erro ou não, pois o método
retorna um cliente:

public Cliente procuraCliente(int id) {
    if (idInvalido) {
        // avisa o método que chamou este que ocorreu um erro
    } else {
        Cliente cliente = new Cliente();
        cliente.setId(id);
        // cliente.setNome("nome do cliente");
        return cliente;
    }
}


Por esses e outros motivos, utilizamos um código diferente em Java para tratar aquilo que chamamos de
exceções: os casos nos quais acontece algo que normalmente não iria acontecer. O exemplo do argumento do
saque ou id inválido de um cliente é uma exceção à regra.


Exceção

Uma exceção representa uma situação que normalmente não ocorre e é algo de estranho ou
inesperado no sistema.
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12.2 Exercício para começar com os conceitos

Antes de resolvermos o nosso problema, vejamos como a Java Virtual Machine age
ao se deparar com situações inesperadas, como divisão por zero ou acesso a um índice
da array que não existe.



	Para aprendermos os conceitos básicos das exceptions do Java,
 teste o seguinte código você mesmo:

class TesteErro {
   public static void main(String[] args) {
       System.out.println("inicio do main");
       metodo1();
       System.out.println("fim do main");
   }

   static void metodo1() {
       System.out.println("inicio do metodo1");
       metodo2();
       System.out.println("fim do metodo1");
   }

   static void metodo2() {
       System.out.println("inicio do metodo2");
       ContaCorrente cc = new ContaCorrente();
       for (int i = 0; i <= 15; i++) {    
           cc.deposita(i + 1000);
           System.out.println(cc.getSaldo());
           if (i == 5) {
               cc = null;
           }
       }
       System.out.println("fim do metodo2");
   }
}


 Repare o método main chamando metodo1, e este, por sua vez, chamando o metodo2. Cada
 um desses métodos pode ter suas próprias variáveis locais, isto é: o metodo1 não enxerga as
 variáveis declaradas dentro do main, e por aí em diante.

 Como o Java (e muitas das outras linguagens) faz isso? Toda invocação de método é empilhada em
 uma estrutura de dados que isola a área de memória de cada um. Quando um método termina
 (retorna), ele volta para o método que o invocou. Ele descobre isso por meio da pilha de
 execução (stack): basta remover o marcador que está no topo da pilha:
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 Porém, o nosso metodo2 propositadamente tem um enorme problema: está acessando
 uma referência nula quando o índice for igual a 6!

 Rode o código. Qual é a saída? O que isso representa? O que ela indica?
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 Essa saída é conhecida como rastro da pilha (stacktrace) e é importantíssima para o
 programador - tanto que, em qualquer fórum ou lista de discussão, é comum os programadores
 enviarem, juntamente com a descrição do problema, essa stacktrace. Mas por que isso aconteceu?

 O sistema de exceções do Java funciona da seguinte maneira: quando uma exceção é lançada
 (throw), a JVM entra em estado de alerta e verificará se o método atual toma alguma precaução
 ao tentar executar esse trecho de código. Como podemos ver, o metodo2 não
 toma nenhuma medida diferente do que vimos até agora.

 Como o metodo2 não está tratando desse problema, a JVM para a sua execução anormalmente
 sem esperá-lo terminar e volta um stackframe para baixo, em que será feita nova verificação:
 "o metodo1 está se precavendo de um problema chamado NullPointerException?"
 "Não..." Volta para o main, em que também não há proteção. Então, a JVM morre (na verdade, quem
 morre é apenas a Thread corrente; se quiser saber mais sobre isso, há um apêndice de Threads e Programação Concorrente no final da apostila).

 Obviamente, aqui estamos forçando esse caso e não faria sentido tomarmos cuidado com ele. É fácil
 arrumar um problema desses: basta verificar antes de chamar os métodos se a variável está com referência nula.

 Porém, só para entender o controle de fluxo de uma Exception, colocaremos o código que vai
 tentar (try) executar o bloco perigoso e, caso o problema seja do tipo
 NullPointerException, ele será pego (caught). Repare que é interessante que
 cada exceção no Java tenha um tipo. Ela pode ter atributos e métodos.



	Adicione um try/catch em volta do for, pegando NullPointerException.
 O que o código imprime?

try {
   for (int i = 0; i <= 15; i++) {
       cc.deposita(i + 1000);
       System.out.println(cc.getSaldo());
       if (i == 5) {
           cc = null;
       }
   }
} catch (NullPointerException e) {
   System.out.println("erro: " + e);
}
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	Em vez de fazer o try em torno do for inteiro, tente apenas com o bloco de dentro do
 for:

     for (int i = 0; i <= 15; i++) {
         try {
             cc.deposita(i + 1000);
             System.out.println(cc.getSaldo());
             if (i == 5) {
                 cc = null;
             }
         } catch (NullPointerException e) {
             System.out.println("erro: " + e);
         }
     }


 Qual é a diferença?
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	Retire o try/catch e coloque-o em volta da chamada do metodo2.

     System.out.println("inicio do metodo1");
     try {
         metodo2();
     } catch (NullPointerException e) {
         System.out.println("erro: " + e);
     }
     System.out.println("fim do metodo1");
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	Faça a mesma coisa retirando o try/catch novamente e colocando-o em volta da chamada do
 metodo1. Rode os códigos, o que acontece?

     System.out.println("inicio do main");
     try {
         metodo1();
     } catch (NullPointerException e) {
         System.out.println("erro: " + e);
     }
     System.out.println("fim do main");
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 Repare que, a partir do momento que uma exception foi catched (pega, tratada, handled),
 a execução volta ao normal.





12.3 Exceções de Runtime mais comuns

Que tal tentar dividir um número por zero? Será que a JVM consegue fazer aquilo que nós
definimos como não existente?

public class TestandoADivisao {

    public static void main(String[] args) {
        int i = 5571;
        i = i / 0;
        System.out.println("O resultado  " + i);
    }
}


Tente executar o programa acima. O que acontece?
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Repare: um NullPointerException poderia ser
facilmente evitado com um if que checaria se a referência é diferente de null.

Outro caso em que também ocorre tal tipo de exceção é quando um cast errado é feito (veremos mais
à frente). Em todos os casos, esses problemas provavelmente poderiam ser evitados por quem programa. É
por esse motivo que o Java não obriga a dar o try/catch nessas exceptions, e a essas exceções damos o nome 
 de unchecked. Em outras palavras, o compilador não checa se você está tratando essas
exceções.


Erros

Os erros em Java são um tipo de exceção que também pode se tratado. Eles representam problemas na
máquina virtual e não devem ser tratados em 99% dos casos, já que provavelmente o melhor a se fazer
é deixar a JVM encerrar (ou apenas a Thread em questão).




12.4 Outro tipo de exceção: Checked Exceptions


Fica claro com os exemplos de código acima: não é necessário declarar que você está tentando
fazer algo onde um erro possa ocorrer. Os dois exemplos, com ou sem o try/catch, compilaram e
rodaram. Em um, o erro terminou o programa, e em outro, foi possível tratá-lo.

Mas não é só esse tipo de exceção que existe em Java. Um outro tipo obriga quem chama
o método ou construtor a tratar essa exceção. Chamamos esse tipo de exceção de checked,
pois o compilador checará se ela está sendo devidamente tratada, diferente das anteriores
conhecidas como unchecked.

Um exemplo interessante é o de abrir um arquivo para leitura no qual pode ocorrer o erro do arquivo
não existir (veremos como trabalhar com arquivos em outro capítulo, não se preocupe com isso agora):

class Teste {
    public static void metodo() {
        new java.io.FileInputStream("arquivo.txt");
    }
}


O código acima não compila, e o compilador avisa que é necessário tratar o FileNotFoundException
que pode ocorrer:
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Para compilar e fazer o programa funcionar, temos duas maneiras que podemos tratar o problema. A
primeira é tratá-lo com o try e catch do mesmo jeito que o usamos no exemplo anterior, de referência nula:

public static void metodo() {

    try {
        new java.io.FileInputStream("arquivo.txt");
    } catch (java.io.FileNotFoundException e) {
        System.out.println("Nao foi possível abrir o arquivo para leitura");
    }

}


A segunda maneira de tratar esse erro é delegá-lo a quem chamou o nosso método, isto é, passar
para a frente.

public static void metodo() throws java.io.FileNotFoundException {

    new java.io.FileInputStream("arquivo.txt");

}


No Eclipse, é bem simples fazer tanto um try/catch como um throws:

Tente digitar esse código no Eclipse:

public class TestaException {
    public static void main(String[] args) {
        new java.io.FileInputStream("arquivo.txt");
    }
}


O Eclipse reclamará:
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E você tem duas opções:


	Add throws declaration, que gerará:

  public class TestaException {
      public static void main(String[] args) throws FileNotFoundException {
          new java.io.FileInputStream("arquivo.txt");
      }
  }




	Surround with try/catch, que gerará:

  public class TestaException2 {
      public static void main(String[] args) {
          try {
              new java.io.FileInputStream("arquivo.txt");
          } catch (FileNotFoundException e) {
              // TODO Auto-generated catch block
              e.printStackTrace();
          }
      }
  }






No início, existe uma grande tentação de sempre passar o problema para frente a fim de que outros o tratem.
Pode ser que faça sentido dependendo do caso, mas não até o main, por exemplo. Acontece que quem
tenta abrir um arquivo sabe como lidar com um problema na leitura. Quem chamou um método no começo
do programa pode não saber ou, pior ainda, tentar abrir cinco arquivos diferentes e não saber em qual
deles houve um problema!

Não há uma regra para decidir em que momento do seu programa você tratará determinada exceção.
Isso dependerá de em que ponto você tem condições de tomar uma decisão em relação àquele erro.
Enquanto não for o momento, você provavelmente preferirá delegar a responsabilidade ao método
que o invocou.


Boas práticas no tratamento de exceções

No blog da Caelum, há um extenso artigo discutindo as boas práticas em relação ao tratamento de exceções.

http://blog.caelum.com.br/2006/10/07/lidando-com-exceptions/
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12.5 Um pouco da grande família Throwable

Uma pequena parte da família Throwable:
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12.6 Mais de um erro

É possível tratar mais de um erro quase que ao mesmo tempo:


	Com o try e catch:

try {
  objeto.metodoQuePodeLancarIOeSQLException();
} catch (IOException e) {
  // ..
} catch (SQLException e) {
  // ..
}




	Com o throws:

public void abre(String arquivo) throws IOException, SQLException {
  // ..
}




	Você pode também escolher tratar algumas exceções e declarar as outras no throws:

public void abre(String arquivo) throws IOException {
  try {
      objeto.metodoQuePodeLancarIOeSQLException();
  } catch (SQLException e) {
      // ..
  }
}






É desnecessário declarar no throws as exceptions que são unchecked, porém é permitido e, às
vezes, facilita a leitura e documentação do seu código.

12.7 Lançando exceções

Lembre-se do método saca da nossa classe Conta. Ele devolve um boolean caso consiga ou
não sacar:

public boolean saca(double valor) {
    if (this.saldo < valor) {
        return false;
    } else {
        this.saldo-=valor;
        return true;
    }        
}


Também podemos lançar uma Exception, o que é extremamente útil. Dessa maneira, resolvemos o
problema de alguém esquecer de fazer um if no retorno de um método.

A palavra-chave throw, que está no imperativo, lança uma Exception.
Isso é bem diferente de throws, que está no presente do indicativo e só avisa da
possibilidade daquele método lançá-la, obrigando o outro método que vá utilizar-se daquele
a se preocupar com essa exceção em questão.

public void saca(double valor) {
    if (this.saldo < valor) {
        throw new RuntimeException();
    } else {
        this.saldo-=valor;        
    }        
}


No nosso caso, lança uma do tipo unchecked. RuntimeException é a exception mãe de todas as
exceptions unchecked. A desvantagem aqui é que ela é muito genérica; quem receber esse erro não
saberá dizer exatamente qual foi o problema. Podemos então usar uma exception mais específica:

public void saca(double valor) {
    if (this.saldo < valor) {
        throw new IllegalArgumentException();
    } else {
        this.saldo-=valor;        
    }        
}


IllegalArgumentException diz um pouco mais: algo foi passado como argumento, e seu método não
gostou. Ela é uma Exception unchecked, pois estende de RuntimeException, e já faz parte da
biblioteca do Java (IllegalArgumentException é a melhor escolha quando um argumento sempre é
inválido, por exemplo, números negativos, referências nulas, etc.).

Para pegar esse erro, não usaremos um if/else, e sim um try/catch, porque faz mais
sentido, visto que a falta de saldo é uma exceção:

Conta cc = new ContaCorrente();
cc.deposita(100);

try {
    cc.saca(100);
} catch (IllegalArgumentException e) {
    System.out.println("Saldo Insuficiente");
}


Podíamos melhorar ainda mais e passar para o construtor da IllegalArgumentException o motivo da
exceção:

public void saca(double valor) {
    if (this.saldo < valor) {
        throw new IllegalArgumentException("Saldo insuficiente");
    } else {
        this.saldo-=valor;        
    }        
}


O método getMessage() definido na classe Throwable (mãe de todos os tipos de erros e
exceptions) retornará a mensagem que passamos ao construtor da IllegalArgumentException.

try {
    cc.saca(100);
} catch (IllegalArgumentException e) {
    System.out.println(e.getMessage());
}
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12.8 O que colocar dentro do try?

Imagine que sacaríamos dinheiro de diversas contas:

Conta cc = new ContaCorrente();
cc.deposita(100);

Conta cp = new ContaPoupanca();
cp.deposita(100);

// sacando das contas:

cc.saca(50);
System.out.println("consegui sacar da corrente!");

cp.saca(50);
System.out.println("consegui sacar da poupança!");


Podemos escolher vários lugares para colocar try/catch:

try {
    cc.saca(50);    
} catch (IllegalArgumentException e) {
    System.out.println(e.getMessage());
}
System.out.println("consegui sacar da corrente!");

try {
    cp.saca(50);
} catch (IllegalArgumentException e) {
    System.out.println(e.getMessage());
}
System.out.println("consegui sacar da poupança!");


Essa não parece uma opção boa, pois a mensagem "consegui sacar"
será impressa ainda que o catch seja acionado. Sempre que temos
algo que depende da linha de cima para ser correto, devemos
agrupá-lo no try:

try {
    cc.saca(50);    
    System.out.println("consegui sacar da corrente!");
} catch (IllegalArgumentException e) {
    System.out.println(e.getMessage());
}

try {
    cp.saca(50);
    System.out.println("consegui sacar da poupança!");
} catch (IllegalArgumentException e) {
    System.out.println(e.getMessage());
}


Mas há ainda uma outra opção: imagine que, para o nosso sistema,
uma falha ao sacar da conta poupança devesse parar o processo
de saques, não chegando nem a tentar sacar da conta-corrente. Para isso, agruparíamos
mais ainda:

try {
    cc.saca(50);    
    System.out.println("consegui sacar da corrente!");
    cp.saca(50);
    System.out.println("consegui sacar da poupança!");
} catch (IllegalArgumentException e) {
    System.out.println(e.getMessage());
}


O que você colocará dentro do try influencia muito
a execução do programa! Pense direito nas linhas que dependem
umas das outras para a execução correta da sua lógica de negócios.

12.9 Criando seu próprio tipo de exceção

É bem comum criar uma própria classe de exceção com o intuito de controlar melhor o uso de suas exceções. Dessa
maneira, podemos passar valores específicos para ela carregar, e que sejam úteis de alguma forma. Criemos a nossa:

Voltando ao exemplo das Contas, façamos a nossa exceção de SaldoInsuficienteException:


public class SaldoInsuficienteException extends RuntimeException {    

    public SaldoInsuficienteException(String message) {
        super(message);
    }
}


Em vez de lançar um IllegalArgumentException, lancemos nossa própria exception com
uma mensagem que dirá "Saldo Insuficiente":

public void saca(double valor) {
    if (this.saldo < valor) {
        throw new SaldoInsuficienteException("Saldo Insuficiente," +  
                                            "tente um valor menor");
    } else {
        this.saldo-=valor;        
    }        
}


E, para testar, crie uma classe que deposite um valor e tente sacar um valor maior:

public static void main(String[] args) {
    Conta cc = new ContaCorrente();
    cc.deposita(10);        

    try {
        cc.saca(100);
    } catch (SaldoInsuficienteException e) {
        System.out.println(e.getMessage());
    }
}


Podemos transformar essa Exception de unchecked para checked, obrigando quem chama esse
método a dar try-catch ou throws:

public class SaldoInsuficienteException extends Exception {    

    public SaldoInsuficienteException(String message) {
        super(message);
    }
}


12.10 Para saber mais: finally

Os blocos try e catch podem conter uma terceira cláusula chamada finally, a qual indica o que
deve ser feito após o término do bloco try ou de um catch qualquer.

É interessante colocar algo que é imprescindível de ser executado, independente se o que você queria fazer deu
certo ou não. A ocorrência mais comum é o de liberar um recurso no finally, como um arquivo ou
conexão com banco de dados, para que possamos ter a certeza de que aquele arquivo (ou conexão) será
fechado, mesmo que algo tenha falhado no decorrer do código.

No exemplo a seguir, o bloco finally será sempre executado independentemente de tudo ocorrer bem
ou de acontecer algum problema:

try {
    // bloco try
} catch (IOException ex) {
    // bloco catch 1
} catch (SQLException sqlex) {
    // bloco catch 2
} finally {
    // bloco que será sempre executado, independente 
    // se houve ou não exception e se ela foi tratada ou não
}


Há também, no Java 7, um recurso poderoso conhecido como try-with-resources, que permite utilizar
a semântica do finally de uma maneira bem mais simples.
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12.11 Exercícios: exceções


	Na classe Conta, modifique o método deposita(double x): ele deve lançar uma exception
 chamada IllegalArgumentException, a qual já faz parte da biblioteca do Java, sempre que o valor
 passado como argumento for inválido (por exemplo, quando for negativo).

	Rode a aplicação, cadastre uma conta e tente depositar um valor negativo.
 O que acontece?

 

	Ao lançar a IllegalArgumentException, passe via construtor uma mensagem a ser exibida. Lembre-se de
 que a String recebida como parâmetro é acessível via o método getMessage() herdado
 por todas as Exceptions.

 Rode a aplicação novamente e veja que agora a mensagem aparece na tela.



	Faça o mesmo para o método saca da classe ContaCorrente, afinal o cliente
 também não pode sacar um valor negativo!

	Validemos também que o cliente não pode sacar um valor maior
 do que o saldo disponível em conta.
 Faça sua própria Exception, SaldoInsuficienteException. Para isso, você precisa criar uma
 classe com esse nome que seja filha de RuntimeException.

 No método saca da classe ContaCorrente, utilize essa nova  Exception.

 Atenção: nem sempre é interessante criarmos um novo tipo de exception! Depende do caso.
 Nesse aqui, seria melhor ainda utilizarmos IllegalArgumentException. A boa prática diz que
 devemos preferir usar as já existentes do Java sempre que possível.



	(Opcional) Coloque um construtor na classe SaldoInsuficienteException que receba
 o valor    que ele tentou sacar (isto é, ele receberá um double valor).

 Quando estendemos uma classe, não herdamos seus construtores, mas podemos acessá-los por meio
 da palavra-chave super de dentro de um construtor. As exceções do Java têm uma série
 de construtores úteis para poder populá-las já com uma mensagem de erro. Então, criemos
 um construtor em SaldoInsuficienteException que delegue para o construtor de sua mãe. Este
 guardará essa mensagem para poder mostrá-la quando o método getMessage for invocado:

 
 public class SaldoInsuficienteException extends RuntimeException {

     public SaldoInsuficienteException(double valor) {
         super("Saldo insuficiente para sacar o valor de: " + valor);
     }
 }


 Dessa maneira, na hora de dar o throw new SaldoInsuficienteException, você precisará passar
 esse valor como argumento:

 if (this.saldo < valor) {
     throw new SaldoInsuficienteException(valor);
 }


 Atenção: você pode se aproveitar do Eclipse para isso: comece já passando o valor como
 argumento ao construtor da exception, e o Eclipse reclamará que não existe tal construtor.
 O quickfix (ctrl + 1) sugerirá que ele seja construido, poupando-lhe tempo!

 E agora? Como fica o método saca da classe ContaCorrente?

 

	(Opcional) Declare a classe SaldoInsuficienteException como filha direta de Exception em
 vez de RuntimeException. Ela passa a ser checked. O que isso resulta?

 Você precisará avisar que o seu método saca() throws SaldoInsuficienteException,
 pois ela é uma checked exception. Além disso, quem chama esse método necessitará tomar uma
 decisão entre try-catch ou throws. Faça uso do quickfix do Eclipse novamente!

 Depois, retorne a exception para unchecked, isto é, para ser filha de RuntimeException,
 pois iremos utilizá-la assim em exercícios de capítulos posteriores.

 




12.12 Desafios


	O que acontece se acabar a memória da Java Virtual Machine?

 




12.13 Discussão em aula: catch e throws com Exception

Existe uma péssima prática de programação em Java que é a de escrever o catch e o throws
com Exception.

Há códigos que sempre usam Exception, porque isso cuida de todos os possíveis erros. O maior
problema disso é generalizar o erro. Se alguém joga algo do tipo Exception para quem o chamou,
quem recebe não sabe qual o tipo específico de erro que ocorreu e não saberá como tratá-lo.

Sim, há casos nos quais o tratamento de mais de uma exception pode ser feito de uma mesma maneira. Por
exemplo, se queremos terminar a aplicação tanto no caso de IOException quanto em SQLException.
Se fizermos catch(Exception e) para pegar esses dois casos, teremos um problema: a aplicação
irá parar mesmo que outra exceção seja lançada. A solução correta seria ter dois catches, mas aí
teríamos código repetido. A fim de evitar o código repetido, podemos usar o multi-catch do Java 7,
o qual permite um mesmo catch cuidar de mais de uma exceção por meio da sintaxe
catch(IOException | SQLException e) { ... }.



	
		Você pode também fazer o curso data dessa apostila na Caelum


		
			
		

		Querendo aprender ainda mais sobre? Esclarecer dúvidas dos exercícios? Ouvir explicações detalhadas com um instrutor?
A Caelum oferece o curso data presencial nas cidades de São Paulo, Rio de Janeiro e Brasília, além de turmas incompany.

		Consulte as vantagens do curso Java e Orientação a Objetos

	



        
        

    



        
        
    
    


        
        

    Capítulo 19
Apêndice - Sockets

    
        
        
            "Olho por olho, e o mundo acabará cego."--Mohandas Gandhi

Conectando-se a máquinas remotas.



19.1 Motivação: uma API que usa os conceitos aprendidos

Neste capítulo, você conhecerá a API de Sockets do Java pelo pacote java.net.

Mais útil que conhecer a API é você perceber que estamos usando aqui todos os conceitos e
bibliotecas aprendidas durante os outros capítulos. Repare também: é relativamente simples
aprender a utilizar uma API, agora que temos todos os conceitos necessários para tal.

Lembre-se de fazer esse apêndice com o Javadoc aberto ao seu lado.
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19.2 Protocolo


Da necessidade de dois computadores se comunicarem, surgiram diversos protocolos que permitissem tal
troca de informação: o protocolo que usaremos aqui é o TCP (Transmission Control Protocol).

Por meio do TCP, é possível criar um fluxo entre dois computadores — como é mostrado no diagrama
abaixo:
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É possível conectar mais de um cliente ao mesmo servidor, como é o caso de diversos banco de dados,
servidores web, etc.

Ao escrever um programa em Java que se comunique com outra aplicação, não é necessário se preocupar
com um nível tão baixo quanto o protocolo. As classes que trabalham com eles já foram
disponibilizadas para serem usadas por nós no pacote java.net.

A vantagem de se usar TCP, em vez de criar nosso próprio protocolo de bytes, é que o ele garantirá
a entrega dos pacotes que transferirmos, e criar um protocolo base para isto é algo bem complicado.

19.3 Porta

Acabamos de mencionar que diversos computadores podem se conectar a um só, mas, na realidade, é muito
comum encontrar máquinas clientes com uma só conexão física. Então, como é possível se conectar a
dois pontos? Como é possível ser conectado por diversos pontos?

Todas as aplicações que estão enviando e recebendo dados fazem isso por intermédio da mesma conexão física,
mas o computador consegue discernir, durante a chegada de novos dados, quais informações pertencem a
qual aplicação. Mas como?
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Assim como existe o IP a fim de identificar uma máquina, a porta é a solução para identificar
diversas aplicações em uma máquina. Essa porta é um número de 2 bytes, varia de 0 a 65535. Se
todas as portas de uma máquina estiverem ocupadas, não é possível se conectar a ela enquanto nenhuma
for liberada.

Ao configurar um servidor para rodar na porta 80 (padrão http), é possível se conectar a ele mediante  essa porta que, junto com o IP, formará o endereço da aplicação. Por exemplo, o
servidor web da caelum.com.br pode ser representado por: caelum.com.br:80

19.4 Socket

Mas se um cliente se conecta a um programa rodando na porta 80 de um servidor, enquanto ele não se
desconectar dessa porta, será impossível que outra pessoa se conecte?

Acontece que, ao efetuar e aceitar a conexão, o servidor redireciona o cliente de uma porta a
outra, liberando novamente sua porta inicial e permitindo que outros clientes se conectem outra vez.
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Em Java, isso deve ser feito por meio de Threads, e o processo de aceitar a conexão deve ser rodado o
mais rápido possível.


	
		Seus livros de tecnologia parecem do século passado?


		
			
		

		Conheça a Casa do Código, uma nova editora, com autores de destaque no mercado, foco em ebooks (PDF, epub, mobi), preços imbatíveis e assuntos atuais.
Com a curadoria da Caelum e excelentes autores, é uma abordagem diferente para livros de tecnologia no Brasil.

		Casa do Código, Livros de Tecnologia.

	


19.5 Servidor

Iniciando um modelo de servidor de chat, o serviço do computador que funciona como base deve,
primeiramente, abrir uma porta e ficar ouvindo até alguém tentar se conectar.

import java.net.*;

public class Servidor {
    public static void main(String[] args) throws IOException {

        ServerSocket servidor = new ServerSocket(12345);
        System.out.println("Porta 12345 aberta!");
        // a continuação do servidor deve ser escrita aqui

    }
}


Se o objeto for realmente criado, significa que a porta 12345 estava fechada e foi aberta. Se outro
programa tem o controle desta porta nesse instante, é normal que o nosso exemplo não funcione,
pois ele não consegue utilizar uma porta que já está em uso.

Após abrir a porta, precisamos esperar um cliente por meio do método accept da
ServerSocket. Assim que um cliente se conectar, o programa continuará. Por isso, dizemos que esse método é
blocante, segura a Thread até que algo o notifique.

Socket cliente = servidor.accept();
System.out.println("Nova conexão com o cliente " + 
    cliente.getInetAddress().getHostAddress()
); // imprime o ip do cliente


Por fim, basta ler todas as informações que o cliente nos enviar:

Scanner scanner = new Scanner(cliente.getInputStream());

while (scanner.hasNextLine()) {
    System.out.println(scanner.nextLine());
}


Fechamos as conexões, começando pelo fluxo:

in.close();
cliente.close();
servidor.close();


O resultado é a classe a seguir:

public class Servidor {
    public static void main(String[] args) throws IOException {
        ServerSocket servidor = new ServerSocket(12345);
        System.out.println("Porta 12345 aberta!");

        Socket cliente = servidor.accept();
        System.out.println("Nova conexão com o cliente " +     
            cliente.getInetAddress().getHostAddress()
        );

        Scanner s = new Scanner(cliente.getInputStream());
        while (s.hasNextLine()) {
            System.out.println(s.nextLine());
        }

        s.close();
        servidor.close();
        cliente.close();
    }
}


19.6 Cliente

A nossa tarefa é criar um programa cliente que envie mensagens para o servidor. O cliente é
ainda mais simples do que o servidor.

O código a seguir é a parte principal e tenta se conectar a um servidor no IP 127.0.0.1 (máquina
local) e porta 12345:

    Socket cliente = new Socket("127.0.0.1",12345);
    System.out.println("O cliente se conectou ao servidor!");


Queremos ler os dados do cliente a partir da entrada padrão (teclado):

    Scanner teclado = new Scanner(System.in);
    while (teclado.hasNextLine()) {
        // lê a linha e faz algo com ela
    }


Basta ler as linhas que o usuário digitar por meio do buffer de entrada (in) e jogá-las no
buffer de saída:

PrintStream saida = new PrintStream(cliente.getOutputStream());
Scanner teclado = new Scanner(System.in);
while (teclado.hasNextLine()) {
    saida.println(teclado.nextLine());
}
saida.close();
teclado.close();


Repare que usamos os conceito de java.io aqui novamente para leitura do teclado e envio
de mensagens ao servidor. No que concerne às classes Scanner e PrintStream, tanto faz de qual lugar
que se lê ou escreve os dados: o importante é que esse stream seja um InputStream/OutputStream.
É o poder das interfaces e do polimorfismo aparecendo novamente.

Nosso programa final:

public class Cliente {
    public static void main(String[] args) 
                    throws UnknownHostException, IOException {
        Socket cliente = new Socket("127.0.0.1", 12345);
        System.out.println("O cliente se conectou ao servidor!");

        Scanner teclado = new Scanner(System.in);
        PrintStream saida = new PrintStream(cliente.getOutputStream());

        while (teclado.hasNextLine()) {
            saida.println(teclado.nextLine());
        }

        saida.close();
        teclado.close();
        cliente.close();
    }
}
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Para testar o sistema, precisamos rodar primeiro o servidor e, logo depois, o cliente. Tudo o que for
digitado no cliente será enviado ao servidor.



Multithreading

Para que o servidor seja capaz de trabalhar com dois clientes ao mesmo tempo, é necessário criar uma
Thread logo após executar o método accept.

A Thread criada será responsável pelo tratamento dessa conexão, enquanto o laço do servidor
disponibilizará a porta para uma nova conexão:

while (true) {

    Socket cliente = servidor.accept();

    // cria um objeto que vai tratar a conexão
    TratamentoClass tratamento = new TratamentoClass(cliente);

    // cria a thread em cima deste objeto
    Thread t = new Thread(tratamento);

    // inicia a thread
    t.start();

}





19.7 Imagem geral
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A socket do cliente tem um InputStream, que recebe do OutputStream do servidor, e tem um
OutputStream, que transfere tudo para o InputStream do servidor. Muito parecido com um
telefone.

Repare que cliente e servidor são rótulos que indicam um estado. Um micro (ou melhor, uma JVM) pode
ser servidor em um caso, mas pode ser cliente em outro.
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19.8 Exercícios: Sockets


	Crie um projeto sockets.

 Faremos um pequeno sistema no qual tudo que é digitado no microcliente
 acaba aparecendo no microservidor. Isto é, apenas uma comunicação unidirecional.

 Crie a classe Servidor, como vimos nesse capítulo. Utilize bastante os recursos do Eclipse
 para não ter de escrever muito!

     package br.com.caelum.chat;

     import java.io.IOException;
     import java.net.ServerSocket;
     import java.net.Socket;
     import java.util.Scanner;

     public class Servidor {
         public static void main(String[] args) throws IOException {
             ServerSocket servidor = new ServerSocket(12345);
             System.out.println("Porta 12345 aberta!");

             Socket cliente = servidor.accept();
             System.out.println("Nova conexão com o cliente " +     
                 cliente.getInetAddress().getHostAddress());

             Scanner entrada = new Scanner(cliente.getInputStream());
             while (entrada.hasNextLine()) {
                 System.out.println(entrada.nextLine());
             }

             entrada.close();
             servidor.close();
         }
     }




	Crie a classe Cliente, como vista anteriormente:

     package br.com.caelum.chat;

     import java.io.IOException;
     import java.io.PrintStream;
     import java.net.Socket;
     import java.net.UnknownHostException;
     import java.util.Scanner;

     public class Cliente {
         public static void main(String[] args) 
                         throws UnknownHostException, IOException {
             Socket cliente = new Socket("127.0.0.1", 12345);
             System.out.println("O cliente se conectou ao servidor!");

             Scanner teclado = new Scanner(System.in);
             PrintStream saida = new PrintStream(cliente.getOutputStream());

             while (teclado.hasNextLine()) {
                 saida.println(teclado.nextLine());
             }

             saida.close();
             teclado.close();
         }
     }


 Utilize os quickfixes e control espaço para os imports e o throws.



	
 Rode a classe Servidor: repare no console do Eclipse que o programa fica esperando.
 Rode a classe Cliente: a conexão deve ser feita, e o Eclipse deve lhe mostrar os dois
 consoles(existe um pequeno ícone na View de Console para você
 alternar entre eles).

 Digite mensagens no cliente e veja se elas aparecem corretamente no servidor.

 
 

	Teste seu programa com um colega do curso usando comunicação remota entre as duas máquinas.
 Combinem entre si quem irá rodar o cliente e quem irá rodar o servidor. Quem for rodar o cliente
 deve editar o IP na classe para indicar o endereço da outra máquina (verifique também se estão
 acessando a mesma porta).


Descobrindo o IP da máquina

No Windows, abra o console e digite ipconfig para saber qual é o seu IP. No Linux (ou no BSD, Mac, Solaris),
vá no console e digite ifconfig.



 

	(Opcional) E se você quisesse, em vez de enviar tudo o que o cliente digitou,
 transferir um arquivo texto do micro do cliente para o servidor? Seria difícil?

 Use bastante o polimorfismo! Faça o cliente ler de um arquivo chamado arquivo.txt (crie-o!)
 e o servidor gravar tudo o que receber em um arquivo chamado recebido.txt.

 




19.9 Desafio: múltiplos clientes

Quando o servidor aceita um cliente com a chamada ao accept, ele poderia chamar novamente este método
para aceitar um novo cliente. E, se queremos aceitar muitos clientes simultâneos, basta chamar o accept
várias vezes e tratar cada cliente em sua própria Thread (senão o método accept
não será invocado novamente!).

Um esboço de solução para a classe Servidor:

    ServerSocket servidor = new ServerSocket(12345);

    // Servidor fica eternamente aceitando clientes...
    while (true) {
        Socket cliente = servidor.accept();
        // Dispara uma Thread que trata esse cliente e já espera o próximo.
    }


[TODO: seria legal essa solução parcial para apenas essa parte!]

19.10 Desafio: broadcast das mensagens

Agora que vários clientes podem mandar mensagens, gostaríamos que o cliente recebesse
as mensagens enviadas pelas outras pessoas. Ao invés do servidor simplesmente escrever as
mensagens no console, ele deve mandar cada uma a todos os clientes conectados.

Precisamos manter uma lista de clientes conectados e, quando chegar uma mensagem (de qualquer
cliente), percorremos essa lista e a mandamos a todos.

Use um List para guardar os PrintStreams dos clientes. Logo depois que o servidor
aceitar um cliente novo, crie um PrintStream usando o seu OutputStream e adicione-o à lista.
E, quando receber uma mensagem nova, envie-a a todos na lista.

Um esboço:

Adicionando na lista:

    while (true) {
        Socket cliente = servidor.accept();
        this.lista.add(new PrintStream(cliente.getOutputStream()));

        // Dispara uma Thread que trata esse cliente e já espera o próximo.
    }


Método que distribui as mensagens:

    void distribuiMensagem(String msg) {
        for (PrintStream cliente : lista) {
            cliente.println(msg);
        }
    }


Mas nosso cliente também recebe mensagens. Então, precisamos fazer com que o cliente,
além de ler mensagens do teclado e enviar ao servidor, simultaneamente também possa
receber mensagens de outros clientes enviadas pelo servidor.

Ou seja, precisamos de uma segunda Thread na classe Cliente, que fica recebendo mensagens do
InputStream do servidor e imprimindo-a no console.

Um esboço:

    Scanner servidor = new Scanner(cliente.getInputStream());
    while (servidor.hasNextLine()) {
        System.out.println(servidor.nextLine());
    }


Lembre-se de que você precisará de no mínimo duas Threads para o cliente e duas para o servidor. Então provavelmente
você terá de escrever quatro classes.

Melhorias possíveis:


	Faça com que a primeira linha enviada pelo cliente seja sempre o nick dele. E quando o servidor
enviar a mensagem, faça-o enviar o nick de cada cliente antes da mensagem.



	E quando um cliente desconectar? Como retirá-lo da lista?



	É difícil fazer o envio de arquivos pelo nosso sistema de chats? Sabendo que a leitura de um arquivo
é feita pelo FileInputStream, seria difícil mandar esse InputStream pelo OutputStream da conexão de rede?
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19.11 Solução do sistema de chat

Uma solução para o sistema de chat cliente-servidor com múltiplos clientes foi proposta nos desafios acima.
Repare que ela não está nem um pouco elegante: o main já faz tudo, além de não tratarmos as
exceptions. O código visa apenas mostrar o uso de uma API. É uma péssima prática colocar toda a
funcionalidade do seu programa no main e também jogar exceções para trás.

Nessa listagem, faltam os devidos imports.

Primeiro, as duas classes para o cliente. Repare que a única mudança grande é a classe nova, Recebedor:

public class Cliente {
    public static void main(String[] args) 
                throws UnknownHostException, IOException {
        // dispara cliente
        new Cliente("127.0.0.1", 12345).executa();
    }

    private String host;
    private int porta;

    public Cliente (String host, int porta) {
        this.host = host;
        this.porta = porta;
    }

    public void executa() throws UnknownHostException, IOException {
        Socket cliente = new Socket(this.host, this.porta);
        System.out.println("O cliente se conectou ao servidor!");

        // thread para receber mensagens do servidor
        Recebedor r = new Recebedor(cliente.getInputStream());
        new Thread(r).start();

        // lê msgs do teclado e manda pro servidor
        Scanner teclado = new Scanner(System.in);
        PrintStream saida = new PrintStream(cliente.getOutputStream());
        while (teclado.hasNextLine()) {
            saida.println(teclado.nextLine());
        }

        saida.close();
        teclado.close();
        cliente.close();        
    }
}


public class Recebedor implements Runnable {

    private InputStream servidor;

    public Recebedor(InputStream servidor) {
        this.servidor = servidor;
    }

    public void run() {
        // recebe msgs do servidor e imprime na tela
        Scanner s = new Scanner(this.servidor);
        while (s.hasNextLine()) {
            System.out.println(s.nextLine());
        }
    }
}


Já o Servidor sofreu bastantes modificações. A classe TrataCliente é a responsável por cuidar de
cada cliente conectado ao sistema:

public class Servidor {

    public static void main(String[] args) throws IOException {
        // inicia o servidor
        new Servidor(12345).executa();
    }

    private int porta;
    private List<PrintStream> clientes;

    public Servidor (int porta) {
        this.porta = porta;
        this.clientes = new ArrayList<PrintStream>();
    }

    public void executa () throws IOException {
        ServerSocket servidor = new ServerSocket(this.porta);
        System.out.println("Porta 12345 aberta!");

        while (true) {
            // aceita um cliente
            Socket cliente = servidor.accept();
            System.out.println("Nova conexão com o cliente " +     
                cliente.getInetAddress().getHostAddress()
            );

            // adiciona saida do cliente à lista
            PrintStream ps = new PrintStream(cliente.getOutputStream());
            this.clientes.add(ps);

            // cria tratador de cliente numa nova thread
            TrataCliente tc = 
                    new TrataCliente(cliente.getInputStream(), this);
            new Thread(tc).start();
        }

    }

    public void distribuiMensagem(String msg) {
        // envia msg para todo mundo
        for (PrintStream cliente : this.clientes) {
            cliente.println(msg);
        }
    }
}


public class TrataCliente implements Runnable {

    private InputStream cliente;
    private Servidor servidor;

    public TrataCliente(InputStream cliente, Servidor servidor) {
        this.cliente = cliente;
        this.servidor = servidor;
    }

    public void run() {
        // quando chegar uma msg, distribui pra todos
        Scanner s = new Scanner(this.cliente);
        while (s.hasNextLine()) {
            servidor.distribuiMensagem(s.nextLine());
        }
        s.close();
    }
}
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